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Hello, this is Eric Bobrow, and in this lesson we're going to continue on roof construction and actually
apply these principles to the roofs on this little sample building we've been working on. We're in
ArchiCAD 14, and we'll look at how it's done in ArchiCAD 10 through 14 in this first part; and then we'll
repeat the process in ArchiCAD 15. [00:28]

In the end of the previous lesson, we had created a bunch of other roofs as samples, and | am going to
go ahead and delete them. | use the Arrow tool and draw a rectangle around all of them, selecting
them, and then hit the Delete or Backspace key, and then Fit in Window. And I'll just zoom in a little bit
with the plus magnifying glass to be able to see the building a little bit more clearly. Now, we're going to
go to the Roof tool to get started here, but | would like to draw the roofs on the upper story, rather than
on the ground floor, because | need to be able to see the outline of the upper building and work the
roofs around them. [01:12]

| will actually need to see both stories to do this, but I'm going to go up to the second floor or upper
story plan here. Now, in order to be able to see to first floor, or the ground floor, I'll right click on this
one and say "Show as Trace Reference". And now we can see both stories while we're working. Now, in
order to do this, we have a very complex roof system or relatively complex, so I'll use the Poly roof
method. And I'm going to be essentially drawing the outline of the lower story to tell it to create a
series of roofs around that outline. Now we're not going to include this upper left area, which is actually
a balcony. We're going to start in this upper corner here, and click all these points for the walls. [02:00]

And | look for the black pencil, and just click these points, and when | get back to the very first point, it
will finish. Now, it asks about how many levels. We're going to do just a single level roof, and the slope
of 4 and 12 is good, or if you want to do it in percent, you can do it at 33.33%. Now we're on the second
floor or the upper story, and | would like to make sure that relative to project zero, which is where on
this particular building, we have the ground floor set up, that these roofs are at 9 feet or 3 m above
there; because these are covering the lower walls rather than the upper ones. So | do need to make
sure that this height is correct. Of course we can adjust it later if it was set floating up in space, but it's
good to do this correct the first time. [02:59]

I'll leave the overhang at 1 foot or say 300 mm and say OK. And you see see how it's created a complex
roof system very easily. Let's take a look in 3D. So I'll go and activate the 3D command here. And we
can see the roofs show up. Now, when | was practicing this earlier, we didn't see anything in the
window. And that was because it was last set for showing what was in the selection or marquee that |



was working with in 3D. So sometimes you need to switch it back to say "Show all in 3D. So if you're not
seeing anything in your 3D window, make sure you are using this command, and say "Show All in 3D",
and then possibly you'll need to Fit in Window using this icon here. [03:50]

Now when | orbit this, you can see that the roofs are sitting inside the building, and of course that isn't
appropriate. So we need to trim them. So I'll just go back to the floor plan, hitting F2 here, or using the
icon for going to the floor plan. In ArchiCAD 14 and earlier, we need to select each of these roofs in turn
and make the change. So in other words, I'll select this one upper roof here, and I'll press down on a
edge or corner and use the option in the pet palette that has the little minus sign, you can see if it's in
the upper right area of the pet palette. Now when we're doing this minus, we can outline a series of
points individually, or we can do a rectangular gesture. And what I'll do is I'll simply say, "Would you
subtract out this part of the building from it?" And you can see how it's now notched that roof around
it. But we of course also have an upper area | want to do, so I'll just again go to the same option. It
remembers that | want to do subtraction, and I'll go from this corner here up. [05:00]

And it doesn't matter if it's bigger than it needs, it's going to subtract anything that overlaps. And now
that piece has been trimmed back neatly. If | go to 3D now and orbit around, we'll see that that
particular roof now is not sticking in there. But | have to repeat the process for each of the other roofs
that is overlapping the building. So I'll go up to this left hand roof, press down and use this minus here,
and then | will go ahead and say that I'd like to subtract out the area that say, I'll use the polygon
method here, and I'll say that this is inside of the roof, or inside of the building. I'll go down to the
intersection snap, I'll zoom in a little bit so you can see this point has a little special snap that is the
intersection of the wall edge line, and the edge of the roof. [05:58]

I'll go across straight until | get the perpendicular, and then I'll zoom out a little bit, or perhaps scroll up
until I can see the corner point there. And maybe zoom out a little bit. And when | go back to that
starting point here, let me just pan down. When | go back to the starting point, I'm basically describing
the shape that | want to remove, which was the point that I'm on, the diagonal point where it met the
wall, and then out on the corner. And I'll click, and you can see how it removed that area. So
sometimes we need the polygon method, sometimes we can use the rectangle. I'll select this roof by
Shift+clicking it. and go to a corner or an edge, and use the pet palette to choose the minus, and I'll just
again switch to the rectangular mode, because | can simply say, "Subtract out everything that is inside
this rectangle." [06:55]

And you can see how it easily notches that out. And again on the final one, here. Go to any corner or an
edge, and subtract out this shape. And | can just basically slice it off that way. So now, very quickly, if |
go to 3D, we can see all of those roofs are cutting around the building. And when | go back to floor plan
with an F2, you can see of course the results that we expect. Now we're on the second or upper floor,
and | am going to go down to the ground floor and take a look. And what you'll see is that the roofs are
showing up if | zoom in on in a little bit with a dashed line here. Now the diagonals are little bit funny
because it's showing two roofs, both with dashes, and the dashes aren't coinciding. So sometimes this
requires some extra manual cleanup for the linework to get the results that you need. [07:50]



And perhaps sometimes people prefer just showing the outline of roofs and not all of the ridge lines or
hip lines or valley lines. We're not going to deal with that in this lesson, but | just wanted to show you
that down below its showing dashed, whereas up in the next story up its showing solid. And that's
because these roofs, if | just look at the general settings of the roofs, are set when | open them up to
show the uncut lines here as a solid line. So basically its showing it as solid on its own story. And then,
there's an option that is under the Options menu, Project Preferences, for construction elements that
says, "How would you like to see elements that are below their home story?" [08:40]

And it says, "l would like to show it with a hidden line or a dashed line or some other option." It's up to
you. So there are some options here. This is under the Options menu, Project Preferences,
Construction Elements. Now, we need to create the roofs for the upper story here. And in the U.S.
template, there are only two stories that exist. In the international template there's actually a story
above that that is already set up. So how do we create a new story when we need it? I'm going to right
click on this story, and when | right click on this view of a story, one of the options is "Story Settings".
And you can see that when | bring it up, it gives me the name of the two stories and their relative
heights. And allows me down below to say, "Insert Above". [09:35]

So I'm going to create a new story. And we'll just call this "Roof". Now, the elevation of the story could
be of any height that you find useful, but | believe that the walls of the above are at 9 feet or 3 m and

I'm going to make the elevation here to be 19 feet. So it's only 9 feet above this story. So if you're in the
metric version, you would set it to say that if the second floor or the upper story is at 3000 mm, and the
walls are at 2700, then the plate height would then be at 5700 mm perhaps. So as long as you
coordinate the walls and roofs, whatever the elevation is that you need, you can set. So I've just
activated or created the roof story by inserting this above, and I've set the elevation to the desired
height. [10:31]

And I'll just say OK. And when | say OK, you'll see that the appearance now has switched, and now in the
floor plan folder here, it's showing that is now listed. And if we look at the title, which I'm pointing at, it
says "3. Roof". Now if you're in the metric system , it would say 2, because you would be two floors
above the ground floor, which is designated as zero. Now you can see the gray or trace here is still
showing the ground floor. What I'd like to do is switch that trace to show the second floor. So I'll right
click on this and say, "Show as Trace Reference", and show the desired story there. Now we can see this
more clearly. [11:20]

So what I'm going to be drawing, this is actually much simpler. I'll be using the Roof tool here, or
activating the Roof tool for the Poly roof method, and simply just clicking on this series of points to
define the roof here. And we can leave the slope, etc. all the same. And so that now that is looking very
clean and we don't have to jog it around anything. Let's take a look in 3D, and you can see those roofs
have come in. Now we do have a little bit of an issue, in terms of the walls being taller than the roofs.
So let's just take a look at this situation. If | select one of these walls, it tells me that it's going from 10 to
20 feet. Soit's actually a little bit higher than | was anticipating. The roofs were set at a different height.
[12:23]



So let me go ahead and adjust those walls. So I'll go back to the appropriate floor plan here. And on this
floor plan, if | activate the Wall tool, and sent say "Select All Walls". I'd like to change their height.
Instead of going up to 20, I'll make them 19. So instead of going from let's say 3000 to 6000, we'd take it
3,000 to 5,700, if you're working in metric. Now, when | go back to 3D, that will help a little bit, but |
think the roofs also should be up higher. So let me just orbit up above here, and let's just select these
roofs. Now, I'll go to the Arrow tool and select one of them, and in ArchiCAD 14 or earlier, we do need
to select them all one at a time in many cases, because they are individual pieces. [13:20]

And you can see that their height, their base3 height, was set at 18 feet. So let me just change that to
19. And you can see how now they jump up, and it looks good. So you can easily adjust, when you have
a mistake, something that looks pretty bad for a moment can be cleaned up. And I'll do one last thing.
I'm going to take off this hip and make it a gable. So | just select it and remove it. And let's just go back
to the floor plan, and you can see that as | zoom in on this area, that there is a gap there. I'll select this
roof with the Arrow tool, go to this node point, and instead of trying to do subtraction, I'll switch the
mode in the pet palette to editing that node. [14:09]

You can see the striped orange line is giving me a guideline. And then if | actually go to this point here,
and you'll see the blue line coming up. I'll just move along it, that allows me to see the line in space
here. So in ArchiCAD 10 through 14, simply hovering over a corner or node point will give me a dashed
line, and then when | just roll my mouse over it without clicking anything, | can get the - it turned into a
dashed orange line. And now it's a little hard to see, I'll zoom in a little bit, and you can see that when |
get over this there's a right angle snap cursor. So click on that, and I'll zoom back out, roll the mouse
wheel, and we'll finally get this other roof selected by Shift clicking on it, go to the corner node, readjust
it until it snaps into position here. [15:09]

You may have to zoom in a little bit to make sure your snapping to the right point, because there's
actually a snap just a little bit higher. You can see the black pencil, the center of the window marker, but
| really wanted to snap to the black pencil which is in line with the roof. So this is now a gable end. If we
go back to 3D it will be a little better. But we don't want any gap in between the walls and the roof, so
I'll just orbit a little bit, turn the orbit mode off, and we'll do finally the last cleanup of the walls, we'll
select this. I'll go to any of these top points of the wall, and use the pet palette. When | press down on
it, the pet palette appears. Take this up high enough to trim to the roof here, and let's use the Solid
Element Operations for this, in case we decide to make any other changes. [16:06]

So Solid Element Operations, when | go to the Design menu, it brings up the palette. It expands the
palette to show the new operations. The wall that's selected, | click on "Get Target Elements", and that
will tell it to be a target. I'll click outside it, and then to deselect, and then I'll select the two roofs that
are going to be cutting it by Shift+clicking on them, and make them operators by clicking on Get
Operator Elements, and then choose the operation to be "Subtraction with Upward Extrusion"”, so that
will remove where the roofs overlap the walls. It will subtract, and everything above that, and | say
Execute. And we've now got this building looking pretty good on the plan and also in 3D. [16:58]



Let's take a look at the elevations here. So I'll scroll down to let's say, east elevation. And let me hide
the Solid Element Operations palette and zoom out to Fit in Window. And you can see that's fairly
clean, respectable looking. I'll go to north elevation, and again, each one of these elevations is looking
much more realistic. We're missing a railing for the balcony, and of course there are other details that
we can put in, but we already | think have a nice little building here in ArchiCAD 14. We might as well
take a look at the sections as well. So I'll double click on this section here, and you can see how that is
appearing. And we have a little bit of an issue on the left side of the section. You can see that the roof
sort of ends without a line and in fact does not extend over the wall. [17:59]

And that is because the actual section marker is not extending far enough. So if that happens, then you
need to adjust it. So I'm going to right click on the section icon here, section in the list of views. And
there's an option to "Select section marker on the home story". And it's a little bit off screen for the
recording, but is says, "Select selection marker on the home story and zoom to it". So this allows me to
see which one it is, and you can see that it is placed nicely, but the endpoint is not going out as far as the
roof overhang. So | need to go to the corner here, press down, use the stretch option in the pet palette,
which you can see is highlighted, and we'll just take this out a little bit. [18:55]

So | take that out, and you can see now it's going far enough. And if | double click on the section, we're
going to see now that section has updated here. And we can look at the other section as well, and it
looks pretty good for a schematic level design model. So let's take a look at how we do roof
construction in ArchiCAD 15. And this is going to be a little simpler than what we just experienced in 14
and earlier. I'll go and delete these ones that we were using for training purposes, and then Fit in
Window. And now I'm going to zoom in to the actual building like this. [19:40]

So here we are on the ground floor, and I'd like to go up to the story above, so I'll go and double click
here on the second floor plan or the next story up, whatever it's called in your version. And now we're
looking at these walls, which are the upper story. But we want to be able to view in a Trace Reference
the lower story. So we'll say, "Show as Trace Reference" the lower story. Now I'll go to the Roof tool,
and here remember, we have different geometry options. So we have a single plane and multi plane.
So we're going to use the multi plane option. And we do have a complex roof shape rather than a
rectangle, so we'll use that option there. [20:24]

Now we can't use the magic wand, because of the shape is a little than what ArchiCAD would trace, so
we have to actually just go ahead and just click on these points here. And | haven't set the height of the
roof properly, so that may need to be adjusted, but we can do that afterward. I'll just click on all of
these points, get to the first one. And you can see how, very similar to ArchiCAD 14, it created a
complex system that went through the upper part of the building. So let's take a look in 3D. So I'll just
say, "Show All in 3D", so we make sure we're seeing everything now. And say Fit in Window. And, oh
yeah, those roofs are set at the wrong height. [21:08]

So I'll go ahead and select this, and when | select one of them, is selects all of them. Now we can say,
"You know the height really should be not 19 feet, it should be 9 feet or 3 m". And now you can see
how it dropped down instantly the entire system. Now it still is sticking into the building, so we have to



fix that. But it's going to be quite a bit simpler than we did in ArchiCAD 14, because | can select the
entire system, press down on a corner, and say I'd like to subtract the same things we did before. |
make sure that I'm in the Complex Polygon method, and then say that I'd like to subtract out. And I'm
just going to outline the upper part of the building. And I'll just go, all of these points here. And I'll
actually just take this out to the outside. So in other words, | want to go down along here to being in
line with this. Now here, | want to be at a point that's in line with this. And how do | get a guideline. Now
in ArchiCAD 14 and earlier, if | just hovered over this point, it would show me a line in space horizontally
and vertically, saying maybe you want one of these guidelines? In ArchiCAD 15, we need to press down
as if we were going to click here. But press and hold, an as we're holding, move it off to the side, and
you see that's proposing this blue guideline. When | let go with my mouse still over it, it will become an
orange line. And now that guideline is available for me to snap to. So you can see now | can use this
intersection snap, and then | can continue back to the first point, which just completes the outline of the
building with the extensions that were taken off the roof outside the building. [23:04]

And so you can see in a single step, this entire roof system has been pulled back. So | think the overhang
here is a little bit more than it needs to be, and | want to change it globally. So I'm just going to with the
roof system selected, | will click on the roof icon and open up the settings. And we'll look at the multi
plane geometry, and we'll see that the eaves overhang has been set to Manual. But | would like to
change it to be an Automatic Offset. So in other words, it will just fix everything here. And I'll take this
to say 1 foot or 300 mm. Now unfortunately, that actually removed the cleanup that | had done there.
So | might have to do it one at a time or do this part first. And then do the other part. [24:07]

So since this was pretty quick to clean up, I'm just going to select this roof, and we'll just use the
subtraction option. Let's just actually do it in - using the Rectangle Create mode. And I'll just say that I'd
like to subtract out this shape, and this is now notched out, this particular corner, and I'll subtract out
again, and make sure that I've got the minus here, and subtract out from this corner up there, and that
removes that. So | have this little trailing end here, and I'll do one more subtraction. I'll make sure to
select subtraction here, and go up to this corner, and remove all of that. And let's take a look then at the
shape that's left, if deselect it and go to 3D, and looks like it's pretty good. What | wanted to get. Just
orbit around and verify that, yes. That looks good. [25:13]

So sometimes you have to do things a second time if you did them in the wrong order. Sometimes it's
hard to anticipate that, so just be aware that there's no mistakes in ArchiCAD. You can always clean
them up. No mistakes that you can't recover from let's say. Now, I'm going to go up to the upper floor
here, and we'll be prepared to - actually we need to create a new story as we did before. Since it's the
U.S. version, we don't have an upper story. So again, I'll say, "Story Settings" by right clicking on one of
the stories in the View Map, and I'll say, "Insert Above", and we'll go "Roof", and I'll set the elevation to
say 19 feet, or 5,700 mm. And now we're on that story. [26:09]

And I'd like to right click on this lower story, the middle story, and say, "Show as Trace Reference", so
now we can outline that. And very quickly, I'll go to the Roof tool and just draw this. Before | set it, I'l
actually make sure that I'm at the right height. So it's going to be at 19 feet here, which is actually at the
base of this story, and we can leave the slope alone. And I'll click OK. So here, I'll just click on this series



of points, make sure I'm in the complex mode rather than the rectangular mode, and it will create this
entire roof system there. And let me just make this again that one foot overhang. So I'll select the roof
system, open it up. | forgot to change the offset to be 1 foot. [27:07]

So we have one more adjustment, which is I'd like to change this upper area from a hip to a gable. So I'll
go to this corner here and say I'd like to adjust it. So if you're finding that it's moving around the whole
roof, you may need switch back and forth a bit in the pet palette until it gets what you're doing. And
you can see that actually the angle is not following my cursor, but if | go out to this point, that is
projecting, | guess that's probably the original distance that the roof was set. It says "Roof Pitch 90".
Whatever point you need to take it out to. You see "Roof Pitch 90" as opposed to anything else, then
you can do that. And | suppose if you just type in 90, then it will immediately do that. So you can see
that actually just typing in 90 for the roof pitch in the tracker will immediately make that work. [28:17]

Now, | want to go ahead and change the offset just for this one side, or reinstate this offset. So I'll press
down on the edge here and choose the option again for affecting just this one pitch. And this one pitch
is not going to be pitched, it's a gable. But | wanted to have an offset, and again, I'll set to be consistent.
One foot or 400 mm, and say OK. So, at this point, if | go to the 3Dwindow here, you'll see that we've
got this system. However those walls on this story are set to be a little too tall. So let me go ahead and
select them. [29:06]

Now | can select them in 3D here, but | will have to rotate around. | can switch to the Orbit mode and
perhaps get to the other side of the building here. And then turn off the Orbit mode and select each of
these walls in turn. And | think | missed one, so I'll just back up. So this is another way that you can
select things is just move around, and when you see the color on it you know you’ve got it. SO | can
change it from 20 to 19, and that works nicely. Of course, this one wall actually needs to be raised, so
again, I'm going to go to a corner here, or an upper corner, and use the pet palette to say | want to make
it taller, take it up high enough, and we'll use the ArchiCAD 15 option under the Design menu for
Connect. And tell it that we'd like it to trim to the roof that's nearby. [30:12]

And that option then says, "Click an element to use as a trimming element", so I'll just click on this roof.
So the cursor changes to have a black roof icon, and you can see the red of this roof is now indicated
that it's selected. And | now need to just say whether I'm keeping the lower part of the wall or the
upper part, and of course I'm going to keep the lower part and click on that. And now that's completed
there. So, we've now completed making that building. Let's take a look at the elevations in here. So
we'll go to east elevation, and zoom out to Fit in Window, and go to the other elevations. And you can
see each one of them in turn looks fairly clean. [31:01]

Let's go to the section, section one, and again we have the same issue that we did with ArchiCAD 14,
where this roof is not looking like it terminates, because the section is actually not extending far enough
to show it. So | will right click on the section in the View Map and say, "Select section marker on the
home story", and zoom to it. Now if you ever try that, and it is gray, it may be because the layer that has
that particular section or all sections is turned off. So you may have to turn that layer on. But here, | can



simply go to the corner, and use the editing option in the pet palette to stretch this, just take it out a
little further. And now if | go back to the section we'll see that it has adjusted to include that. [31:57]

And we'll go to the other section as well, and zoom out a little bit, and it looks quite clean for a
schematic level design model. So this concludes our series of lessons on roof construction in ArchiCAD
14 and earlier, and ArchiCAD 15, both the general series of learning basic techniques as well as the
specific ones for creating roofs for the sample building that we're working on. So this has been Eric
Bobrow, and | look forward to getting your comments and questions, please add them below the lesson
page in the comments area. Thanks for watching. [32:41]



